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Introduction

The TruSight HLA Assign™ 2.1 software (hereafter referred to as "Assign 2.1") assists
with the assignment of a human leukocyte antigen (HLA) type. The software is designed
to analyze data from libraries prepared with the Illumina® TruSight® HLA v2 Sequencing
Panel for DNA and then sequenced on the Illumina sequencing system.
Using Assign 2.1, you can import sequence data, perform base calling, edit sequences,
and compare a consensus sequence with a library of sequences of HLA alleles.
Assign 2.1 has the following features and functionality:
} Import sequences from multiple samples and multiple loci per sample into a user-

friendly interface
} View sample identifiers, loci headers, sequence reads, base calls, and allele

assignments
} Complete analysis audit trail
} Sort allele assignments based on regions of each locus, such as core exons, all exons,

or entire sequences
} Generate reports that include CWD alleles, G groups, and P groups
} Phase-resolve paired-end sequence data from Illumina TruSight HLA libraries

sequenced on the Illumina sequencing system

IMGT/HLA Database
Assign 2.1 compares a sample sequence with a library of sequences from known alleles
listed in the IMGT/HLA database, which comprises sequences of the human major
histocompatibility complex, known as the human leukocyte antigen (HLA). The
IMGT/HLA database includes sequences for the World Health Organization (WHO)
Nomenclature Committee for Factors of the HLA System. The IMGT/HLA database is
part of the international ImMunoGeneTics (IMGT) project (www.imgt.org).

Performance Characteristics
Assign 2.1 can import sequence data from samples generated by the TruSight HLA v2
Sequencing Panel into a single project.

Base Call Accuracy
Assign 2.1 contains a unique base caller that improves the accuracy of heterozygous base
calls. However, sequence data quality and depth of sequencing coverage can influence
base call accuracy.

Limitations
Poor quality data including sequences with background noise or low depth of
sequencing coverage might result in incorrect base calls and incorrect typing. Assign 2.1
includes a simple visual interface to view read quality and depth of sequencing
coverage, which enables rapid identification of poor read quality and low depth of
sequencing coverage.
Assign 2.1 compares a sample sequence with a library of sequences from known alleles
listed in the IMGT/HLA database. The report lists those allele combinations in the library
that are identical to the sample sequence. However, the same sequence might be derived
from alleles yet to be described and whose sequence is not yet part of the library.
Therefore, caution is advised when interpreting the genotype report as an HLA type.
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ComputingRequirements andCompatibility

To ensure optimal performance, use the following minimum computing requirements:
} 1 GHz or faster 64-bit Intel quad-core processor, or equivalent
} 16 GB RAM, minimum
} 16 GB available hard disk space
} Recommended screen resolution—1920 × 1080 pixels
Sequence data files can be stored locally or on a network location. Depending on network
performance, the software might experience a significant delay in processing while files
are imported from a network location.

Computer Operating System and Software
Assign 2.1 runs on Windows and requires Windows Vista, Windows 7, Windows 8,
Windows Server 2008, or Windows Server 2012 operating systems.
Assign 2.1 is not compatible with the following editions of Windows: Embedded
(including Windows on the Illumina sequencing system), RT, Starter, Mobile, and Phone,
or any hardware that does not support a standard keyboard, mouse, and monitor.
Microsoft Excel 97, or later, is required for generating Excel reports from Assign 2.1.

Compatible Data File Formats
Assign 2.1 is compatible with the FASTQ file format, either zipped (*.fastq.gz) or
unzipped (*.fastq). The Illumina sequencing system generates these file formats. For more
information about the FASTQ file format, see the MiSeq Reporter Generate FASTQ
Workflow Reference Guide (document # 15042322).
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Installation

Illumina recommends administrator access to the computer before installing Assign 2.1.
Make sure that the computer is connected to the internet to facilitate system updates with
new libraries and other files when needed.

1 Double-click the installer (*.msi) file and follow the prompts to install the software.

2 Review the License Agreement.

3 Accept the terms in the License Agreement, and then click Next.

4 Select the Installation Folder location. Illumina recommends that you accept the
default location. Click Next.

5 Select shortcut options, and then click Next.

6 Click Install to begin the installation.

7 When the installation is complete, click Finish.

NOTE
In a default installation, the reference library files, as well as the CWD, P, and G group files
are also installed. Updated reference files are available semiannually from the Illumina
TruSight HLA support website. At a minimum, updating annually is recommended.

http://support.illumina.com/sequencing/sequencing_kits/trusight-hla-sequencing-panel-kit/downloads.html
http://support.illumina.com/sequencing/sequencing_kits/trusight-hla-sequencing-panel-kit/downloads.html
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GettingStarted

1 Double-click the Assign 2.1 icon on the desktop or in the installation location.

2 In the Operator Login dialog box, select the operator from the drop-down list.
The default operator is admin.

3 Enter the password.
The default password for the admin operator is cg01.

NOTE
Illumina recommends that you do not change the admin password.

4 Click Submit to start the software.

Figure 1 Operator Login

Add License
1 In the System group, click Update.

2 Browse to the Assign 2.1 license file obtained from Illumina, and then click Open.
Licenses can also be stored in the software installation folder.

3 Click Done, and then restart the software.

NOTE
License keys are provided with a fixed time frame (eg, 6 months). To obtain a new license
key, contact Illumina Customer Service.

Add Operators
1 Double-click the Assign 2.1 icon on the desktop or in the installation location.

2 In the Operator Login dialog box, from the Operator drop-down list, select an
operator.
The default operator is admin.

3 Enter the password.
The default password for the admin operator is cg01.

4 ClickMore to expand the Operator Login dialog box and access the Edit Users
section.

5 In the Edit Operator field, enter a new operator name.

6 Enter a password for the new operator and retype the same password for
verification.

7 From the Default Settings drop-down list, select TruSight HLA.
Select this setting for all operators analyzing TruSight HLA data. Operators with
sufficient privileges can modify settings directly in Assign 2.1.

8 From the Operator Level drop-down list, select from the following options.

mailto:customerservice@illumina.com
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Operator Level Permissions

First Reviewer (edit only) Cannot change settings.
Can edit sequences not yet approved by a final reviewer.
Cannot sign the final review checkbox.

First Reviewer (with access to
settings)

Can change settings.
Can edit sequences not yet approved by a final reviewer.
Cannot sign the final review checkbox.

Final Reviewer (with full access) Can change settings.
Can edit sequences not yet approved by a final reviewer.
Can sign the final review checkbox.

Figure 2 Add Operator

9 Click Add/Update.

Import and Analyze Sequences
1 Click an open document tab to choose the import destination. To create a document,

click the File button and select New or press Ctrl+N.

2 On the Home tab, in the Data group, click Import and Analyze.

3 Navigate to the folder containing the FASTA/FASTQ/GZ files.
The software automatically detects the version of the HLA-B and HLA-DRB primers
used.

4 Use the Ctrl or Shift keys to highlight the desired files. Click Open to begin import
and analysis.

NOTE
Each sample generates a FASTQ file for Read 1 and Read 2. Make sure that you select both
FASTQ files.
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Importing sequences can take from minutes to hours depending on the number of files
imported and the computer system performance. During import, Assign 2.1 is
unavailable and the application title bar indicates that the software is not responding.
The software responds after import and analysis is complete.
The first import takes slightly longer to analyze after the initial installation and after a
reference update. During the first import, only a single user can use the software.

TIP
To abort an import and close Assign 2.1, from the computer Task Manager, highlight the
application and click End Task.

After you import sequences into Assign 2.1, analysis begins automatically. Analysis
includes alignment of reads, base calling, phasing, IMGT/HLA reference alignment, and
HLA typing.

Importing Errors
After the analysis of imported sequences is complete, either of the following warnings
appear to indicate that the files were not successfully imported.
} No sample identifier/delimiter

} There are no dashes (-) in the file name as expected.
} There are no appropriate characters before the first dash to name the sample.

} No target identified/delimiter
} An appropriate gene name is missing or incorrect (eg, A, B, C, DPA1, DPB1,
DQA1, DQB1, DRB1, HLA).

} Unable to combine 1 or more paired end files.
} Only a single read was imported for 1 or more samples.

FASTQ sample file names typically have the following format:
} samplename-HLA-date_S1.FASTQ.gz (eg, 00001234-HLA-04262016_S5_L001_R1_

001.fastq.gz, 00001234-HLA-04262016_S5_L001_R2_001.fastq.gz)
} For more information, see the TruSight HLA v2 Sample Sheet Template (part #
1000000012322).
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Navigating the Interface

Figure 3 Assign 2.1 Interface

A File menu—Allows you to create new, open, and save sequences in Assign 2.1.
B Home tab—Provides access to change settings and views.
C Sample panel—Lists the samples in a project, expands to show each locus typed, and

tracks reviewer comments and the laboratory analysis pipeline. For more information, see
Sample Panel on page 12.

D Navigator—Helps you navigate to base positions of interest. For more information, see
Navigator on page 15.

File Menu
The File menu is located to the left of the Home tab. Click the down arrow to open the
File menu. Use the File menu to create new, open, and save projects.

Figure 4 File Menu

Click Save or Save As to save aligned reads, the Sample Consensus Sequence, and user
edits.
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Home Tab
The Home tab is divided into the following groups: Data, Settings, Reports, Options,
Annotation, Views, Window, and System.

Figure 5 Home Tab

Data
The Data group allows you to import and analyze sequence data.

1 In the Data group, click Import and Analyze.

2 Navigate to the folder containing the FASTQ files.

3 Use the Ctrl key to select individual files or the Shift key to select a group of files that
you want to import and analyze. Use Ctrl + A to select all the files in a folder. The
search box at the top right of the import dialog can also be used to find a particular
sample or locus for analysis. When searching for files, it is possible to create a project
with input files from multiple folders.

4 Click Open.

NOTE
Each sample generates a FASTQ file for Read 1 and Read 2. Make sure that you select both
FASTQ files. For optimal analysis, both Read 1 and Read 2 FASTQ files are imported and
analyzed simultaneously.

Settings
The TruSight HLA setting is the default configuration for the Results panel. To change
the default configuration, select customized settings in the Reports, Options, and
Annotation groups, and then click Update in the Settings group.

Reports
The Reports group allows you to generate 2 types of reports.
} Report types are Genotyping and FASTA.

} Genotyping report file formats are text, Excel, or XML.
} FASTA reports are saved in FASTA format.

For more information, see Generating Reports on page 33.

Options
The Options group allows you to switch between viewing options.
} Codons—Switches views between nucleotide and codon numbering.
} Filtered—Removes allele pairs from the Results panel that are not consistent with

base calls that have been confirmed.
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Annotation
The Annotation group allows you to consolidate annotations into the following groups:
} G Groups—Consolidates the Results panel list into G groups.
} P Groups—Consolidates the Results panel list into P groups.
} All Alleles—Shows all allele matches in the Results panel.
The CWD Set shows a list of the Common and Well-Documented (CWD) alleles, which
are indicated in bold in the Results panel.
The Fields dropdown allows you to limit the view of alleles in the results list to the
specified number of fields. The default is set to 3. If you select All, the sequence used for
the typing is automatically expanded to the entire gene for all loci. When the number of
fields is decreased, alleles can appear several times in the results table. Identical allele
pairs can occur because there are 3rd or 4th field differences with resulting mismatch
differences.

Views
The Views group allows you to navigate between panels to view sequence data in
different ways. Use the Show drop-down list to choose the Summary, Coverage, Reads,
Alignment, or Reference view.

Figure 6 Views Group

} Summary—Comprises 3 panels.
} Typing Summary panel—Shows the types assigned.
} Quality Summary panel—Shows the percentage of base calls with quality ≥ Q30.
} Coverage Summary panel—Shows the mean depth of sequencing coverage.
For more information, see Summary View on page 18.

} Coverage—Shows the mean coverage and base call composition across the
amplicon. For more information, see Coverage View on page 21.

} Reads—Shows reads used in base calling. For more information, see Reads View on
page 31.

} Alignment—Shows a comparison of the Sample Consensus Sequence and the allele
pairs lists in the Results panel. For more information, see Alignment View on page 32.

} Reference—Shows a comparison of the Sample Consensus Sequence and the
reference sequences for a locus. For more information, see Reference View on page 32.

Window
In the Window group, theWindows list allows you to control open file windows.
Click New Window to duplicate the active window in a new tab. The active window file
name appears in bold on the tab.
ClickWindows to open a dialog box that allows you to activate, save, or close a
currently open window.
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Figure 7 Windows Dialog Box

} Select window—Lists the open file windows. Click a file name to highlight it.
} Activate—Click to activate the highlighted file window.
} OK—Click to close the dialog box without applying changes.
} Save—Click to save the highlighted file.
} Close Windows—Click to close the highlighted files.

System
The System group allows you to update and view information within the Assign 2.1
software.
Click Update to open a dialog box that allows you import keys, references, NMDP codes,
and CWD files.
Click About to open a dialog box that provides the software version and licensing
information.

NOTE
CWD sets cannot be toggled and changed dynamically in the user interface. To change the
CWD file, select Update in the Settings tab and restart the software.

Sample Panel
The Sample panel shows the sample names, the loci sequenced for each sample, the
IMGT/HLA reference release, and the status of the review for each locus.

Figure 8 Sample Panel

A IMGT/HLA reference
B Samples and Loci
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C Review hierarchy, report enabling, and locus-specific commenting

IMGT/HLA Reference
The first row in the Sample panel shows the IMGT/HLA reference database used for
assignment of HLA nomenclature to the sample sequence. For more information, see
IMGT/HLA Database on page 3.
The following example indicates specific information about the database:
IMGT/A 3.23.0.0 2016-01-19
} IMGT is the reference database
} A is the gene name
} 3.23.0 is the IMGT/HLA database release version
} 2016-01-19 is the date of the IMGT/HLA release
Assign 2.1 converts sample sequences into HLA nomenclature version 3.0, established in
2010, in agreement with the WHO Nomenclature Committee for Factors of the HLA
System.
The HLA nomenclature uses the following format:
HLA-A*02:01:01:02L

HLA The HLA Prefix

- The hyphen separates the gene name from the HLA prefix.

A The gene name.
For TruSight HLA, the gene name can be A, B, C, DRB1, DRB3, DRB4,
DRB5, DQB1, DPB1, DQA1, or DPA1.

* The asterisk separates the gene name from the sequence information.

02 Field 1—The allele group; alleles that encode an antigen.

: A colon separates fields.

01 Field 2—Specific alleles that differ at the protein level from
DNA substitutions and result in nonsynonymous amino acid
substitutions.

: A colon separates fields.

01 Field 3—Synonymous DNA substitutions within coding regions of the
gene.

: A colon separates fields.

02 Field 4—Differences in the noncoding regions of the gene.
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L This expression modifier is present regardless of the number of fields
reported. As of date, the following modifiers are possible:
•N denotes Null—An allele that is not expressed.
• L denotes Low—An allele encoding a protein with significantly
reduced or low cell surface expression.

• S denotes Secreted—An allele encoding a protein that is expressed as
a secreted molecule only.

• Q denotes Questionable—An allele with a mutation that has
previously been shown to have a significant effect on cell surface
expression, but is not confirmed. Therefore, its expression remains
questionable.

Samples and Loci
Click a sample name to view the loci that have been identified for the selected sample.
Click a locus to view information for the selected locus in the Sequences and Results
panels.

Review Hierarchy
The review hierarchy section of the Sample panel includes 5 columns, which allow for
multiple levels of review and comment for each sample and each locus listed. The
columns are labeled C, A, 1, 2, and R. Each review level is tracked and audited.
} Column C—By default, the box in column C is white. Right-click the sample or locus

to add a comment related to the review. When comments are present, the box
changes to light blue. Comments added in column C are included in the full
genotyping report.

} Column A—By default, the box in column A is yellow. When the sample is verified
at all positions indicated in the Navigator, the box in column A changes to green
automatically.

} Column 2—By default, the box in column 2 is yellow. When the second review is
complete, click the yellow box to change it to green, indicating the second review is
complete and locking the sample. No further edits are possible unless the box is
cleared manually.

} Column 1—By default, the box in column 1 is yellow. After the first review is
complete, click the yellow box. The box changes to green, which indicates that the
first review is complete.

} Column R—A green box in column R indicates that the locus is included in
generated reports. Click the red box to prevent reporting on the locus.

Sample Panel Options
Additional options are available for any locus listed in the Sample panel. To view
options, right-click on a locus name. The following options are available:
} Show Comments—Shows any quality warnings or comments about a sample.
} Edit Comments—Opens a field to add or edit comments about the selected sample.

These comments appear on the report. A light blue box in column C indicates that a
comment is present.

} Reanalyze—Removes any edits and trims made to the selected locus. This function
does not completely restore the locus to its original state after import.

} Remove—Removes the selected locus from the project.
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Figure 9 Sample Panel Options

Navigator

Use the Navigator to navigate to a base position of interest, confirm base calls, or make
base call edits. You can drag the Navigator anywhere on the screen.

Figure 10 The Navigator

Basic Navigation

Navigation Icon Description

Click the up and down arrows to navigate between loci in the Sample
panel.

Click Accept to confirm a base call at a specific position.
Click Reject to change a previously accepted base call.

Use the previous and next arrows to navigate between base positions
highlighted in the Confidence Indicator. For more information, see
Confidence Indicator on page 25.

Use the first and last arrows to navigate to the base positions
highlighted at either end in the Confidence Indicator.

Click Go to make a selection.
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Advanced Navigation
Figure 11 Advanced Navigation

A Base Selection
B Active Nucleotide Position andMismatch List
C Confidence Indicator
D Phase Tracks List
E Indel Details
F Nucleotide Position Field Change

Base Selection
The highlighted base indicates the base call at the current position. Multiple highlighted
bases indicate that more than one base was positively identified at the current position.
A highlighted indicates an insertion. A highlighted indicates a deletion.

1 To add or remove a base at the current position, click A, C, G, or T, or select from the
base selection list.

2 Click Accept to accept the selected base and move to the next low confidence
position.

3 To change a previously accepted base call, click Reject to enable editing.
Use with the Filtered option in the Options group to eliminate allele pairs from the
Results panel that are not consistent with confirmed base calls. For more information, see
Options on page 10.
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Mismatch List
The Mismatch list shows the selected position. Select the down arrow to show all
mismatch positions for the selected allele pair in the active mismatch columns.
To move the cursor to a selected position, enter a number in the nucleotide position field
and click Go, or select an option from the list to move to that position.

Confidence Indicator
The Confidence Indicator shows a numerical value from 0 to 99 for the selected base.
A value of 0 indicates low confidence and a value of 99 indicates high confidence.
The Confidence Indicator value is associated with the coloring on the Confidence
Indicator. Dark red indicates low confidence and white indicates high confidence. For
more information, see Confidence Indicator on page 25.

Phase Tracks List
Use the Phase Tracks drop-down list to switch between layers (sequence and phase
tracks) in a locus.

Indel Details
At a position where an insertion or deletion is present, the appropriate + (insertion) or –
(deletion) box is highlighted in blue. The length of the insertion or deletion and the bases
included in that insertion or deletion are indicated in the space between those symbols.

Nucleotide Position Field Change
The default numbering begins at the first base of the gene. Use the drop-down list to
change the numbering system. You can also view the position of a base within an exon.
Use cDNA numbering to determine the position within the coding sequence.
} Full Gene—Position in gene sequence based on the locus consensus sequence.
} Groups

} cDNA—Position in cDNA. In this view, introns are numbered individually
beginning at 1 in each intron.

} Regions— For a particular position of interest, choose the region of the gene, enter
the relative position in the mismatch list, and then click Go. Use this feature for
quick navigation.
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Summary View

After imported files have completed analysis, the default view is the Summary view. To
see the Summary view later, click Show in the Views group, then click Summary.
Alternatively, hover the mouse cursor over the blue box in the upper-left corner of the
view in the Coverage, Reads, Alignment, or Reference views, and then click the blue
arrow that appears.
The following Summary panels are available within the Summary view:
} Typing Summary panel
} Quality Summary panel
} Coverage Summary panel

Navigating the Summary Panels
To move between Summary panels, hover over the blue box in the upper-right corner of
a Summary view and click the blue arrow that appears. This arrow cycles through the
Summary panels.

Typing Summary Panel
The Typing Summary panel shows the samples and types assigned to each locus for
each sample. In addition to the typing results, this panel shows whether sequence or
expression ambiguities exist, each of which warrant further investigation.
Use multiple monitors or increase the screen resolution on your monitor to expand the
number of viewable fields for each locus. The recommended screen resolution is 1920 x
1080 pixels.

Figure 12 Typing Summary Panel

The Typing Summary panel uses the following markers:
} Active sample—A blue highlight indicates the active sample. Click the highlighted

area to open the sample and locus in the Coverage view for further investigation.
Complete fields indicate an unambiguous typing result.

} Ambiguous expression—A # indicates an ambiguous expression in an allele typing.
} Ambiguous fields—A double dash (--) indicates an ambiguous field in the typing

result. For example, --:01 indicates an ambiguity in the first field, 01:-- indicates an
ambiguity in the second field, and 01:01:-- indicates an ambiguity in the third field.
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} Confidence warning, red—A red box immediately to the left of an allele pair
indicates a locus that might warrant further investigation. This warning can indicate
insufficient coverage or read quality.

} X shown for second allele—An X shown for the second allele indicates that no
heterozygous positions were detected in the analyzed sequence. The presence of an X
in the summary screen does not constitute confirmation of homozygosity.

} Bold text—Indicates a CWD allele.

Quality Summary Panel
A quality score, or Q-score, is a modified Phred score that measures the probability of an
incorrect base call. During Illumina sequencing, each base in a read is assigned a
Q-score. A higher Q-score indicates a smaller probability of error. For example, a Q-score
of 30, indicated as Q30, represents a 1 in 1000 chance of an incorrect call with a
corresponding 99.9% call accuracy.
The Quality Summary panel shows the percentage of base calls with Q30 or higher
scores for each locus. A confidence warning appears for loci when the percentage of base
calls with a Q30 score is 75% or less.

Figure 13 Quality Summary Panel

Coverage Summary Panel
The Coverage Summary panel shows the mean depth of sequencing coverage for each
locus in the project. The depth of sequencing coverage is the number of observations of a
particular base in the sequence data. Warnings are present when loci do not meet
specifications of 100x average coverage. If the 2 alleles of a locus are split between 2
groups (eg, DQB1 and DQB1G06), a warning appears when the group does not meet
specifications of 50x average coverage.

Figure 14 Coverage Summary Panel
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Gene Summary
Hover the mouse cursor over an allele typing to see the following summary information.
} Min Depth—Minimum sequence coverage across the sequence used for the typing

call. The default minimum depth is all exons.
} Mean Depth—Average depth of sequencing for the locus.
} Percent Q30—Percentage of bases > Q30.

NOTE
When alleles from more than 1 group are present, the summary shows results for the first
listed allele.

Figure 15 Gene Summary Popup
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CoverageView

The Coverage view comprises the Confidence Plot, Locus Structure, and Phase
Block Display, the Sequences panel, and the Results panel. To see the Coverage view, in
the Views group, click Show, and then click Coverage.

Figure 16 Coverage View

A Confidence Plot, Locus Structure, and Phase Block Display—Shows a view of the high-
level locus structure, such as UTRs, introns, and exons, indicates base call confidence and
position, and indicates blocks of phased sequence. For more information, see Confidence
Plot, Locus Structure, and Phase Block Display on page 21.

B Sequences Panel—Shows consensus reference sequence, sample sequence, base calls,
depth of sequencing coverage, base call quality, and alternate sequence reads. For more
information, see Sequences Panel on page 22.

C Results Panel—Shows the allele combinations that most closely match the sample
sequence, and shows the mismatches between the sample sequence and the reference
sequence when present. For more information, see Results Panel on page 28.

Move the Coordinate scroll box in the Sequences panel to find positions where base call
confidence is low. Use the Results panel to find mismatches with allele pairs.

Confidence Plot, Locus Structure, and Phase Block Display
Three rows span the width of the screen at the top of the Coverage view.

Figure 17 Confidence Plot, Locus Structure, and Phase Block Display

A Confidence Plot
B Locus Structure
C Phase Block Display

Click a row to move the blue line, which indicates the region in view in the Sequences
panel.
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Confidence Plot
The Confidence Plot uses colors to show positions where base call confidence might
warrant further investigation.

Figure 18 Confidence Plot colors

} Black indicates no coverage. Common reasons for no coverage include the following:
} The amplicon does not cover the full genomic sequence for the analyzed locus
} The reference sequence contains an insertion that is absent in the sample

} Increasing shades of red indicate any of the following conditions:
} Sequence coverage ≥ Q30 is below 100x
} Mean quality score for base calls at this position is low
} A base above noise threshold is not called in consensus
} A base below noise threshold is called in consensus

} White indicates complete coverage.

Locus Structure
The Locus Structure uses yellow to indicate an exon/coding sequence and white or gray
to indicate an intron/noncoding sequence.

Figure 19 Locus Structure colors

} Bright yellow—Exons that are in the active Mismatch Column of the Results panel.
} Dark yellow—Exons that are not currently in the active Mismatch Column of the

Results panel.
} White—Noncoding regions that are in the active Mismatch Column of the Results

panel.
} Gray—Noncoding regions that are not in the active Mismatch Column of the Results

panel.

Phase Block Display
In the Phase Block Display, regions are either light gray or black.

Figure 20 Phase Block Display colors

} Light Gray—Regions where bases are phased together
} Black—Sections where phase linkage is lost
The first phasing block begins at the beginning of the gene and extends until the last
heterozygous position that is able to be phased. The last phasing block continues from
the last heterozygous position through to the end of the gene.

Sequences Panel
The Sequences panel on the Coverage view is composed of the Sequences section and the
Base Calling section.
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Sequences Section
The Sequences section of the Sequences panel includes information from comparisons of
reference sequences with sample sequences. These rows are updated when you select
different allele pairs in the Results panel.

Figure 21 Sequences Section

A Coordinates
B Locus Consensus Sequence
C Sequence Edit Indicator
D Allele 1 Reference Sequence
E Allele 2 Reference Sequence
F Sample Consensus Sequence
G Confidence Indicator
H Phasing Track

TIP
If cDNA is selected for Groups, press CTRL+A in the Sample Consensus Sequence to
alternate between nucleotide and amino acid views.

The consensus sequence rows in the Sequences section (rows B and E) include
International Union of Pure and Applied Chemistry (IUPAC) degenerate base
designations.

Code Bases Description
W Weak
S Strong
M Amino
K Keto
R Purine
Y Pyrimidine
B not A
D not C
H not G
V not T
N all bases
* no base call
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Coordinates

Figure 22 Coordinates

A Gene coordinates
B Coordinate scroll box—Drag the gray box to scan along coordinates
C Sample name and locus
D Highlighted base coordinate in the exon, intron, or UTR (from Sequences panel)
E Highlighted base associated codon coordinate in the gene (from Sequences panel)
F Amplicon start position and location
G Amplicon stop position and location

Locus Consensus Sequence
The Locus Consensus Sequence represents a collection of common variants and motifs.
Rare variants are not included.
} Yellow indicates exonic/coding sequence
} White indicates intronic/non-coding sequence
} Blue indicates insertions or deletions present in some alleles
For HLA-DRB1 and HLA-DQB1, the Sample Consensus Sequence is compared with
sequences of alleles that have been divided into groups with similar intronic sequence
structure. Therefore, the consensus sequence represents the consensus of the best
matched allele group.
} HLA-DRB1 alleles are split into 4 groups: DRB1G01, DRB1G03, DRB1G04, and

DRB1G07
} HLA-DQB1 alleles are split into 2 groups: DQB1 and DQB1G06

Sequence Edit Indicator
The Sequence Edit Indicator row shows a color-coded edit status and acceptance status
of each base in the sequence. The base edit status changes when you edit the originally
called sequence using the Navigator.

Color Code Edit status Acceptance status

Black (default) Not edited Not accepted

Green Not edited Accepted

Blue Edited Not accepted

Blue/Green Edited Accepted

Allele 1 Reference Sequence
The Allele 1 Reference Sequence shows the IMGT/HLA reference for an allele in the
highlighted allele pair selected in the Results panel.
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} A base is displayed in this row when the allele sequence differs from the Sample
Consensus Sequence for the sample, or the position is heterozygous.

} Blank positions indicate that the reference sequence is missing for the selected allele.
} A dot (.) indicates that the allele sequence is identical to the observed sequence at the

selected position.

Allele 2 Reference Sequence
The Allele 2 Reference Sequence shows the IMGT/HLA reference for an allele in the
highlighted allele pair selected in the Results panel.
} A base is displayed in this row when the allele sequence differs from the Sample

Consensus Sequence for the sample, or the position is heterozygous.
} Blank positions indicate that the reference sequence is missing for the selected allele.
} A dot (.) indicates that the allele sequence is identical to the Sample Consensus

Sequence at the selected position.

Sample Consensus Sequence
The Sample Consensus Sequence shows the consensus sequence of the sample
sequenced with the TruSight HLA Sequencing Panel.

Confidence Indicator
The Confidence Indicator is a per-base representation of the Confidence Plot. The
confidence of a base call at any given position can vary based on several factors,
including balance of the alleles, noise threshold, depth of coverage, and sequence quality.
White in the Confidence Indicator denotes a high confidence base call. A bright red
Confidence Indicator denotes base calls in which any of the following conditions have
occurred:

1 Sequence coverage ≥ Q30 is below 100x

2 Mean quality score for base calls at this position is low

3 A base above noise threshold is not called in consensus

4 A base below noise threshold is called in consensus
Use the Navigator to move between red confidence flags. For more information, see Basic
Navigation on page 15.

Phasing Track
For heterozygous allele combinations, the Phasing Track rows show the phase
relationship between bases connected by single reads or paired reads. A phase
assignment is made only when most phasing sequences are concordant.
The top row corresponds to Allele 1/PHASE1 in the Results panel and the bottom row
corresponds to Allele 2/PHASE2. If there is a large distance between heterozygous
positions and the software is unable to link phase, there might be rare instances where
the top row corresponds to Allele 2/PHASE2.

Base Calling

Base-level information appears below the Sequences section of the Sequences panel.
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Figure 23 Base Calling

A Primary base called
B Approximate allele ratio
C Base call ratio
D Depth of sequencing coverage
E Approximate noise threshold
F Other base calls
G Sequence reads covering that base position that were not included in the consensus

sequence for the sample

Right-click on a read to open a menu.
} Copy Sequence—Places all the bases in the read on the clipboard
} Copy Aligned—Places the bases used during alignment on the clipboard
} BLAST Sequence—Submits the full sequence to NCBI BLAST
} Copy Pair—Places the sequence of a read pair on the clipboard
} Show Warnings—Shows Q30 coverage or mean quality warnings for the sample

Primary Base Called
In the Primary Base Called section, the following colors indicate the most frequently
occurring base call for a given position.

Figure 24 Primary Base Called Color Indicators

} A—Green
} C—Blue
} G—Black
} T—Red
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Figure 25 Primary Base Called

Approximate Allele Ratio
When a base location is highlighted, the top pink line indicates the approximate mean
read depth ratio of the second allele present in the sample for heterozygous loci.

Base Call Ratio
Base calls are shown using a logarithmic scale, as follows:
} Lowest section has a ratio between 0% and 1%
} Middle section has a ratio between 1% to 10%
} Highest section has a ratio between 10% to 100%

Depth of Sequencing Coverage
The depth of sequencing coverage is shown with gray bars for each base using the
logarithmic scale in parentheses:
} Lowest section shows coverage depth between 0x and 10x
} Middle section shows coverage depth between 10x and 100x
} Highest section shows coverage depth between 100x and 1000x

NOTE
If the coverage is below 30, no call is shown.

Approximate Noise Threshold
Noise is a common byproduct of amplification fidelity, specificity, sequencing errors, and
sequence alignment. Assign dynamically sets a threshold for noise at any given base
position. A pink dashed line indicates the Approximate Noise Threshold at all base
locations. Typically, base calls below the noise threshold are not called.

Other Base Calls
The Other Base Calls section shows the base calls that differ from the most frequently
occurring base call for a given position and use the same color indicators used in the
Primary Base Called section.

Sequence Reads
The Sequence Reads section contains calls that are not included in the Sample
Consensus Sequence at the highlighted base position.
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Figure 26 Sequence Reads

The quality of the base call for alternate reads, as reported in the FASTQ file, is shown
below the sequence in a gradient of red.
} Dark red—Lowest quality base call.
} Light pink—Highest quality base call.

Results Panel
In the Coverage view, the Results panel lists all the IMGT/HLA allele pairs that exactly
match or closely match the Sample Consensus Sequence. The Results panel also
provides information for each of the allele pairs listed.

Figure 27 Results Panel

A Allele columns
B Common andWell-Documented (CWD) alleles (in bold)
C IMGT/HLA reference coverage (regions that are not orange indicate reference coverage)
D Mismatch columns
E Differences column



C
overage

V
iew

TruSightHLA Assign 2.1 RUOSoftware Guide 29

Allele Columns
In the Alleles columns, all allele pairs appear in order based on the number of
mismatches they contain when compared to the Sample Consensus Sequence. Allele
pairs with no mismatches appear at the top of the columns followed by pairs with
increasing numbers of mismatches.
When no heterozygous positions are detected in the sequence used for the typing (default
is all exons), the Allele 2 column contains an X. The presence of an X does not constitute
confirmation of homozygosity. When a heterozygous position is found in the active
sequence, a second allele is reported. When the results table or report is truncated to 2 or
3 fields, the second allele can appear identical.

Common andWell-Documented (CWD) Alleles
In the Results panel and Summary panel, CWD alleles are shown in bold.

IMGT/HLA Reference Coverage
The allele pairs are banded white and gray by alternating rows for ease of viewing.
Sometimes, the allele includes orange, which indicates that a part of the reference
sequence is missing in the IMGT/HLA reference for that allele. The allele container width
is directly proportional to the amplicon length.
The shading represents only exon sequence coverage and does not indicate coverage in
noncoding regions.

Figure 28 IMGT/HLA Reference
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Mismatch Columns
The number of mismatches in the selected regions appear in the columns to the right of
the allele pairs.

Figure 29 Mismatch Columns

A Mismatches in core exons; additional positions for expression mutations that are known.
For a list of core exons, see the customer release notes for the reference used.

B Mismatches in remaining exons.
C Mismatches in noncoding sequence (introns and UTRs).
D Mismatches in phasing of Allele 1.
E Mismatches in phasing of Allele 2.

Navigating the Mismatch Columns
Of the 5 possible mismatch columns, the Core and Exons columns are activated upon
import. Click the Core column header to expand or collapse the Exons column. Click the
Exons column header to expand or collapse the N-C column. The phase mismatch
columns are present only if necessary to resolve a sequence ambiguity.
Phasing mismatches are only calculated for the allele pairs with the lowest number of
mismatches in the core regions.

Differences Column
The Differences Column indicates the location of differences between the allele pairs
relative to the first allele pair listed.
Where ambiguities exist, the regions in which they might be resolved are indicated in
this column.
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ReadsView

The Reads view shows the sequence reads used in base calling for the selected position.
To see the Reads view, in the Views group, click Show, and then click Reads.

Figure 30 Reads View

A Nucleotide Sequences
B Base call quality from FASTQ file—Quality is shown in light pink (highest quality) to

dark red (lowest quality).
C Read direction arrow—Indicates the direction of the read (ie, forward or reverse).
D Read scroll arrows—Use the scroll arrows to view the next batch of reads. You can also

navigate by pressing Page Up and Page Down on your keyboard.

To hide reads for a specific nucleotide at the base selected, press the Shift key and the
nucleotide letter simultaneously. The reads reappear using the same keys. For example,
press Shift + A to hide the reads calling A at the selected position.
Right-click on a sequence to open a menu that includes the options to copy the sequence
to the clipboard, send the sequence to BLAST for alignment, or display warnings for a
sample.
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AlignmentViewandReferenceView

The Alignment view and Reference view provide comparisons of the Sample Consensus
Sequence and your data against the IMGT sequences.

Alignment View
The Alignment view shows a comparison of the Sample Consensus Sequence and the
allele pairs listed in the Results panel. Click the headings Allele 1 or Allele 2 to add or
remove the contribution from the alleles in that column. To see the Alignment view, in
the Views group, click Show, and then click Alignment.

Reference View
The Reference view shows a comparison of the Sample Consensus Sequence and the
reference sequences for a locus. To see the Reference view, in the Views group, click
Show, and then click Reference.
You can limit the reference alleles that appear in the Reference view. Enter the reference
alleles of interest into the lower field of the Navigator, and then click Filter to the right of
the text field. Alleles that contain the text entered in the box are shown. You can enter
multiple entries, separated by commas, into the filter field.

Figure 31 Limiting Reference Alleles
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GeneratingReports

Types of Reports
Assign 2.1 generates a genotyping report or a FASTA report.
} Genotyping Report—Reports on a single sample or locus or all samples and loci in

the project.
} FASTA Report—Reports the Sample Consensus Sequence using the IUPAC

designations.
} Fragment Analysis—Reports for the distribution of DNA fragments clustered and

read by the Illumina sequencer and imported into Assign 2.1.
Reports can be customized with a logo, page numbers, date and time, and other
references about the report. For more information, see Changing the Full Report Logo on
page 35.

Genotyping Report
Click Reports to launch the reporting tool.

Figure 32 Genotyping Report

Generating a Full Report
A full genotyping report includes a header with your preferred logo, page numbers,
created date and time, sample name and references used, and the CWD set used.

1 On the Genotyping tab, in the Filters section, use the Sample list to select the
samples to include in the report. Select All to include all samples in the project.

2 From the Locus list, select an individual locus to include in the report. Select All to
include all loci in the project.

3 In the Sorting section, select either sample Name or Locus to sort the report.
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4 In the Fields section, select the number of fields to report from the list.

NOTE
By default, the results panel is set to 3 fields. Reporting more fields than the results
panel gives all possibilities at the additional field level.

5 In the Full Report section, use the Sample lists to select Summary or Auditing from
the list. Select Empty if a selection list is not needed.
} Summary—Includes any warnings regarding the typing and the allele pairs that
are compatible with the Sample Consensus Sequence (as edited) for each locus
selected in the Filters section. Additional modifications to this section of the report
are available in Summary Options.

Figure 33 Warning Description

} Auditing—For each Locus selected in the Filters section, the Auditing report
includes the reviewer status as either Pass or Fail and whether all positions have
been confirmed as either Pass or Fail. The report stamps the date, time, and user
for each item passed. Additional modifications to this section of the report are
available in Audit Options.

6 In the Full Report section, use the Layers lists to select the level of layer detail to
include in the report. Select Empty if a selection list is not needed.
} Sequences—For each locus selected in the Filters, the Sequences report prints the
Sample Consensus Sequence (as edited).

} Edit List—For each locus selected in the Filters, the Edit List report shows the
edited positions, the edit that was made, and the user that made the edit.

} Mismatch List—When selecting the Mismatch List layer for reporting, set values
in theMismatch Limits section. To obtain the desired mismatch list in the report,
enter the desired combination of number of mismatches and select the relation to
best match from the list. The mismatch limits apply to the entire gene sequence.
This feature is useful for novel alleles.

7 [Optional] Select Table to export an Excel workbook with separate worksheets for the
3 summary screens instead of a Full Report.
In addition to the 3 summary screens, the Table report includes a worksheet that
displays the allele balance for each locus, in which the frequency of the second allele
is displayed. The Table report also includes a worksheet that displays the frequency
of reads that were determined to be the result of a PCR crossover event and have
been removed from the analysis.

8 In the Summary Options section, select the checkbox for each option to include in the
report.

Summary Option Description

Full Allele List Includes all alleles.

P Groups Includes P groups. For more information, see
hla.alleles.org/alleles/p_groups.html.

http://hla.alleles.org/alleles/p_groups.html
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Summary Option Description

G Groups Includes G groups. For more information, see
hla.alleles.org/alleles/g_groups.html.

NMDP Provides the NMDP code corresponding to the
matching allele pair for a locus.

Differences Includes the information in the differences column of
the Results panel.

Trim Introns When the “Sequences” layer is selected for reporting,
intron sequences are removed from the sequences and
only cDNA sequence is provided in the report.

NOTE
When 2 or more perfect matches are available, creating an ambiguous result, the
software first checks whether the alleles share a G group and then shorts them
by G group. If no G group relationship exists, then Assign 2.1 shorts by P group
and if no P group relationships exist, then the software shorts sequentially lowest
to highest. When G groups are present (or P groups when G groups are not
present), these groups are displayed on the Summary screen and in the
Summary Report. In addition, the ambiguity strings are then reported on a new
“Ambiguities” tab on the Summary Report.

9 In the Audit Options section, select Save to generate a history of save and load
events. Select Confirm to include a history of reviewer confirmations.

Figure 34 Auditing Report

10 In the Output Format section, select from the following formats:
} Text—Generates a report of the selected options into text format.
} Excel—Generates a report of the selected options into an Excel spreadsheet.
} XML—Generates a report of the selected options into a tagged *.xml file that is best
suited for importing into an external database.

} Page Breaks—Adds page breaks to the Excel spreadsheet.

11 [Optional] Select Duplicate Homozygote Calls to print 2 alleles instead of allele 1
and X for putative homozygous samples.

12 Click Report. Excel reports generate and open automatically in Excel. Text or XML
reports generate when you choose a save location on your computer.

Changing the Full Report Logo
You can alter the image by directly editing the Excel template included with Assign 2.1.
To change the logo, open Excel then choose the Genotyping.xlt template file. In a default
installation, the template is located in C:\ProgramData\Conexio Genomics\Assign
TruSight HLA v2.1\data\templates. For a custom installation folder, navigate to the
appropriate folder and then choose data\templates\Genotyping.xlt. To replace the logo
image, under Print, view Page Setup and edit the header and footer.

http://hla.alleles.org/alleles/g_groups.html


36 Document # 1000000010450 v01

FASTA Report
The FASTA file format is a simple text-based format that has become a standard
bioinformatics tool for representing genetic sequences. The FASTA format begins with a
description line that includes a greater than symbol ( > ). The next line in the FASTA is
the Sample Consensus Sequence using the IUPAC designations.

1 On the Home tab, in the Reports section, select FASTA from the Type list.

2 Click Reports to launch the reporting tool.

3 On the FASTA tab, in the Output Filters and Numbering section, use the Sample list
to select an individual sample to include in the report. Select All to include all
samples. The sample name is included automatically in the FASTA description line
preceding the sequence.

4 From the Locus list, select an individual locus to report on the selected samples.
Select All to include all the loci for the samples selected. Select the checkbox to insert
the locus name into the FASTA file (eg, > SampleName_IMGT/A).

5 From the Layer list, select a single layer to restrict output. Select the checkbox to
insert the layer name into the FASTA file.

6 From the Group list, select a designated group of regions to restrict output.

7 From the Region list, select a designated region, such as an exon. Select the checkbox
to insert the region name into the FASTA file.

8 In the Sort by section, select either sample Name or Locus to sort the report.

9 In the Options section, select the Pad Ends checkbox to add N base calls to each
sequence to cover the entire amplicon.

10 Click Generate Report, and then choose a save location on your computer.

Fragment Analysis
The Fragment Analysis is an Excel report that provides details of the distribution of
fragment sizes imported into Assign for each sample and locus.

1 Click Reports to launch the reporting tool.

2 On the Fragment Analysis tab, do 1 of the following:
} Select a single sample in the project
} Select all the samples and select a single locus or all the loci from the dropdown
lists

3 Click Report to generate the fragment analysis.
The Fragment Analysis automatically opens in Excel.
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RevisionHistory

Part # Date Description of Change

Document #
1000000010450 v01

October
2016

Updated for Assign 2.1 RUO TruSight HLA Software. Added
Fragment Analysis section and information about PCR crossover.

Document #
1000000010450 v00

May
2016

Initial Release.
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Technical Assistance

For technical assistance, contact Illumina Technical Support.

Website www.illumina.com

Email techsupport@illumina.com

Table 1 Illumina General Contact Information

Region Contact Number Region Contact Number
North America 1.800.809.4566 Japan 0800.111.5011
Australia 1.800.775.688 Netherlands 0800.0223859
Austria 0800.296575 New Zealand 0800.451.650
Belgium 0800.81102 Norway 800.16836
China 400.635.9898 Singapore 1.800.579.2745
Denmark 80882346 Spain 900.812168
Finland 0800.918363 Sweden 020790181
France 0800.911850 Switzerland 0800.563118
Germany 0800.180.8994 Taiwan 00806651752
Hong Kong 800960230 United Kingdom 0800.917.0041
Ireland 1.800.812949 Other countries +44.1799.534000
Italy 800.874909

Table 2 Illumina Customer Support Telephone Numbers

Safety data sheets (SDSs)—Available on the Illumina website at
support.illumina.com/sds.html.
Product documentation—Available for download in PDF from the Illumina website. Go
to support.illumina.com, select a product, then select Documentation & Literature.

TruSightHLA Assign 2.1 RUOSoftware Guide

http://www.illumina.com/
mailto:techsupport@illumina.com
http://support.illumina.com/sds.html
http://www.illumina.com/support.ilmn


Illumina
5200 IlluminaWay
SanDiego,California92122U.S.A.
+1.800.809.ILMN (4566)
+1.858.202.4566 (outsideNorth America)
techsupport@illumina.com
www.illumina.com
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